CEIl Progress Report (20/03/13)

Appendix 2

Project Projects Completed During 2012/13 Focus for 13/14
Project Complete
Theme A: Children, Education &
Skills
* Agreement enacted re: High Borrans *Ongoing monitoring of income realisation and performance
*Established plan for school meals, Meals on Wheels & child care increases for
Service Delivery Model / Income 021/12.. . . . , Ongoing
Generation . otlfled parents/clients re: implementation of agreed price changes
* Revised Secondary Strategy
* New business model for Early Years & School Improvement Service (including
income generation plans)
» Consultation with service users and professionals re: establishing a Vulnerable * Development of new models and structures for Children's Centres; Early
Pupils Team (incl Head Teacher Briefings) Life Centres; Support Services for young people; & Specialist Family
* Report to Shadow Health & Wellbeing Board on development of an Attachment,  |Support Programmes
Assessment & Intervention Programme for vulnerable 0-22 mnth olds * Consultation on models and new structures
* Integrated Community Budget and Troubled Families Strategies into single * Implementation of new structures
Troubled Families Operational Plan * Programme of Workforce Development
) . * Phase 2 consultation on new service completed * Full implementation of new models of working 31.03.14
Prevention & Early Intervention |, New school based Out of Hours provision established & running
» Consultation undertaken re: proposed Early Help & Support Service
» Appointment of Troubled Families Manager
* Establish Troubled Families Interim Team
* Implement Crisis Intervention Team (new date)
* Establish Vulnerable Pupils Team
* Finalisation of Early Help & Support Model
* Phase 2 consultation on new service completed * Reduction in out of borough placements
Integrated Disability Service * New Integrated Disabilty Strategy & service model: Phase 1 established * Reduction of 4 posts over 2 years 31.03.14
(Partnership) » Service Manager for Integrated Disability Service appointed Most of the savings for this project will be from the full year effects of the
* Phase 2 Implementation work undertaken in 2012/13
* Review of all supplies & services contracts , o _ o
Procurement « Renew/decommission contracts as a result of review *Ongoing monitoring of income realisation and performance Complete
* New senior mgt structure implemented
New Operating Model Complete Complete
» Manager for Employment & Skills appointed * Redesigned service offer
» Conduct Service Review of current provision for 14-25 year olds with » Consultation on service offer and new structures
_ - regard to national policy changes * Implementation of new structures 31.07.13
Enterprise & Employability + Review roles and responsibilities » Programme of Workforce Development
* New service modelagreed * Full implementation of new service offer
« Establish strategy for high quality provision for young people 14-25
» Enacted agreement re: extended offer for milk & fruit at Key Stage 2 » Ongoing monitoring of income realisation and performance
Other General Fund - School |, Enacted agreement re: breakfast offer for special schools - Base budget adjusted to reflect school meals and Meals on Wheels Complete
Related price increases
Young Mayor New CEI Project * Budget reduction of £5k 30.04.13

NTC Confidential

Page 1



CEIl Progress Report (20/03/13)

Appendix 2

Project

Projects Completed During 2012/13

Focus for 13/14

Project Complete

New CEI Project

* Realignment of Participation & Advocacy Teams
» Consultation on new structures

* Action plan for Learning Disabilities service / client reviews in place

(following BPR process in June).

Participation & Advocacy * Implementation of new structures 31.07.13
* Programme of Workforce Development
* Full implementation of new service offer
New CEI Project * Proposed restructure with loss of two Senior School
School Improvement Service Improvement Officer posts 31.07.13
Restructure » Consultation on new structures
* Implementation of new structures
Review of Funding for Childcare New CEI Project » Extension of free 2 year old education provision 30.09.13
Places
New CEI Project * Review services charged to Public Health
Public Health - Child Related * Defrayed costs to be paid by PH budget to reflect PH services 31.03.2014
provided by Council
Review of School PEI Model New CEI Project * Full review of school PFI model 31.03.14
New CEI Project * Full review of delivery of all CYPL services across North
Review of Non School Buildings Tyneside to achieve more effective use of assets and \ 31.03.14
improve service delivery
. . New CEI Project * Implementation of new adoption allowances scheme (full
Review of Adoption Allowances implementation of review started in 2012/13 30.04.2013
Theme A: Adult Social Care
* Reorganised contracts for 2012. * Roll out of Crisis Response Services
* Review of crisis response services completed. * Develop new model for the Adult Social Care Gateway
Modernising S {ind Peool » Cabinet approval * Agree variations to existing contractual arrangements for the
0 ernlsm% upporting Feople 1, Implementation (Sept - Mar) provision of of housing related support services 31.03.14
ervices * Post project evaluation » Complete reviews and agree contract variations for jointly
commissioned Learning Disabilities services
* Negotiate service changes with providers
* Inter team pathways and processes designed.
* Role of Welfare Benefits Team reviewed.
* Introduce Manager's weekly forum
_ del f * Review FACS policy and guidance
Operating Model for Assessment & |, Review risk assessment guidance and practice. Complete Complete
Care Management » Adult Mental Health Teams reviewed.
* Psychiatry of Old Age Services (POAS) Team reviewed.
* Social care out of hrs service live.
* Reablement / intermediate care out of hrs live.
* Analysis of current customers complete
. *G ts established
Targeted Care Package Reviews overnance arrangements estabisne Complete Complete
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Project Projects Completed During 2012/13 Focus for 13/14
Project Complete
* Remodelled points-based Resource Allocation System (RAS) live for all
client groups
Remodel Resource Allocation . Agreeq and delivered RAS approach for carers.
System (RAS)/Set Contingenc * Established RAS monitoring panel. Complete Complete
y 9€NCY 1. Introduced outcome based support planning within AIS system.
* Review of pilot and development of action plan
* Monitor price point and RAS roll out
* Costs calculated and agreed with PCT
Maximise income * New contracting/commissioning agreement in place - Complete Complete
discussions ongoing with PCT
Roll out reablement for Mental  |* Internal provider restructure in place . * Develop/Explore alternative funding options
Health/ Learning Disability services |* New mental health service contracts are established. * Review of complex cases
: : « Reablement model developed - accommodation and community based « Review of current locality commissioning arrangements 30.09.2013
& review all services/explore ' velop y eV . cality g 9
outsourcing » Completed service reviews * Mini tendering exercises
o : * Project due to commence later in the programme.
Maximise Commgmty & Vquqt_ary N/A 31.03.15
Sector volunteering opportunities
Other one-off efficiencies (Review |* Post deleted from structure
. g Complete Complete
of Training Provision)
+ Consultation complete.
Client contributions * Individual assessments completed. Complete Complete
* New charging arrangements in place.
« Staffing structure for resource centre agreed and
implemented.
Intermediate Care Rationalisation |* Building decommissioned Complete Complete
» Review complete and findings communicated
* Individual reassessments completed.
* Plans communicated /agreed with Board.
* Financial allocation agreed and transferred.
Reablement (NHS) * Reablement Pathway to include prevention of admission programmes for Complete Complete
chronic obstructive pulmonary disease (COPD) and pulmonary
rehabilitation patients
New CEI Project » Consultation on eligiblity criteria
Home Care Reab'ement Service ° ReV|eW eX|S|tng bUSineS prOCGSSGS 30092013
* Implementation of new business processes
New CEI Project * Draft policy produced
» Comprehensive Programme of Engagement
Maximum Spend Framework « Cabinet approval for policy development 30.06.2013
* Policy development implemented for new users and those with changing
needs
Adult Social Care Repair Fund New CEI Project » Base budget adjustment to reflect previous budget decisions 30.04.2013
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Projects Completed During 2012/13

Focus for 13/14

Project Complete

Personalisation Staffing Structures

New CEI Project

» Implementation of reablement client pathway

* Ensure 100% of eligible users in receipt of personal budget
» Consultation with partners

* Identification of alternative providers

30.09.2013

Extra Care Housing

New CEI Project

» Consultation with existing tenants
» Budget proposals established
* Implementation of new charging arrangements

30.04.2013

In House Learning Disability Short
breaks

New CEI Project

* Review provision

* Prepare business cases

» Consult on business cases/options

* Decision on preferred option(s)

* Phased implementation of preferred option(s)

31.10.2013

Integration of Reablemnent
Services

New CEI Project

* Multi agency implementation plan

 Agree operational plans within generic pathway & ASC
operating model

» Complete review of employment services & options for
delivery

» Complete review of shared lives services & options for
development

« Joint initiatives; market development; soft market testing

31.03.2014

Commissioned Mental
Health Services

New CEI Project

* VfM Review
» Outcomes negotiated with providers
* Implement changes

31.10.2013

Welfare Reform Administration

New CEI Project

* Preferred model identified

* Eligibility criteria ratified

* Procurement arrangements (white goods & furniture) - current
link

* Voucher system (Utilities & mobile top ups) procured

* Procurement arrangements (white goods & furniture) -
re-procured

* Alignment with ASC Gateway

30.06.2013

Community Safety & Adult
Safeguarding - Internal Restructure

New CEI Project

» Consultation

* Structure agreed

* Interviews

* Personnel appointed

30.04.2013

Health Targeted Reviews

New CEI Project

* Improved client pathways
* Training & development re: Continuing Health Care

31.03.2014

Aids, Adaptations, Equipment &
Loan

New CEI Project

* Remove vacant post from structure
* Remove basic low level equipment from catalogue

31.03.2013

Reconfiguration of Public Health &
Community Based Services

New CEI Project

* Review services charged to Public Health
* Defrayed costs to be paid by PH budget to reflect PH services
provided by Council

31.03.2014
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Project Projects Completed During 2012/13 Focus for 13/14
Project Complete
Theme B
* Procurement process completed
Business Package ) Partpgr appomted and contract signed *Ongoing governance and monitoring of contract and performance Ongoing
* Mobilisation complete
* Services transferred
» Shared service arrangement for Audit & Risk established.
Shared Services » Shared Legal Service trial established, with the aim of establishing a framework for |«Ongoing monitoring of sharing arrangement Ongoing
longer-term shared services
* Structure agreed
Corporate Core » Consultation complete * Embed new structure Complete
* Implementation complete
Client Arrangements * Client arrangements implemented *Ongoing governance and monitoring of contract and performance Complete
: . * Review of all Library provision following the opening of new facilities
* Service remodelling complete L ) . L L
: . . » Consolidation of staffing and operational activity in our 5 main indoor
* Income generation projects implemented
» Shiremoor and Howdon Community Centres - invitations to submit an Expression centres
C&CS Service Review o . * Reviewing charges and maximisation of income 31.03.14
of Interest invited and received. .o . .
Ly . , * Reduction in operational and programme subsidies
» St Mary's Lighthouse - expressions of interest for new management arrangements - ) : ,
. ) » Continuing exploration of the scope for community ownership
invited and received. o ) : :
* Revision of team structure to reflect investment and reconfiguration
* Procurement process completed
. * Partner appointed and contract signed . . o :
Technical & Property Package |, Mobilisation complete Ongoing governance and monitoring of contract and performance Ongoing
* Services transferred
 Analysis of top 250 suppliers resulting in improved performance, resilience and
value for money within contracts with Kier; SSEC; and SITA Suez Ltd;
: . » Comprehensive review of category spend. * Implement actions in new Procurement Strategy
Commercial Capacity & : . i . ,
* Comprehensive overhaul of Fees and Charges. * Focus on 'Supply North Tyneside' to support local businesses Ongoing
Procurement . . . . . ,
* Integration with Balfour Beatty following appointment * Focus on Tier 3 expenditure
* Procurement transferred to Balfour Beatty
* New Procurement Strategy (2013-17) agreed
* Organisational culture exercise complete * Roll out new revised Leadership Programme
* New Workforce Strategy and Pay Policy agreed » Agree and implement revised staff suggestion scheme (VOICE 2)
* Review of VOICE complete » Work with services on issues arising from Staff Survey Ongoing
« Staff survey complete « Skills audit for Tier 3 Managers (alongside revised IPR process)
Workforce « Skills audit for Business & Technical Teams
* Employee benefits scheme improved and implemented
* Employee values developed
» Extensive HR support to CEl, including: HR1 restructuring; terms & conditions;
Union negotiation; and TUPE transfer.
Overhanging Overheads Complete Complete
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Project Complete
Theme C
» Agreed Annual Operating Plan 2012/13 with SITA. * Recycling processing procurement completed
* Signed up to sustainable procurement portal (WARPIt) * Deliver Year 2 Weekly Collection Support Scheme projects to maintain
Waste * Weekly Collection Support Scheme bid successful (£3.355m over 3 yrs) focus on waste minimisation and recycling Ongoing
* Recycling contract extended with price reduction and new procurement initiated
+ 890 illuminated Bollards replaced with reflective ones * Residential bulk lamp replacement - complete with Mayflower control
* Part night switch off trial (A189) gear - begins
o  Savings achieved on cyclical maintenance regimes * Orange lamp (SOX) replacement continues
Streetlighting * New LED lamps installed in Edgemount Estate, Killingworth * Lower wattage High Mast lamps/control gear 31.03.16
* Action Plan for low energy bulb replacement; programmable control gear » Lower wattage lamps/control gear for Coast Road
(Mayflower 2); residential lamp replacement agreed
 Successful implementation of carbon budgets and monitoring across top 54 * Work with Capita Symonds on new energy saving projects
consuming properties (+ live monitoring of power usage enabled on intranet) * NTC to be 'flagship' authority for Northumbrian Water water saving
« Establishment of 'Watch Your Step' campaign, toolkits and training - resulting in  |project
extensive culture change across Council * 'Power Down' software for NTC PC's
* Automated Meter Reading installed across 700 meters » Continuing programme of energy saving work on NT Homes - incl. boiler
» Schools modernisation investment programme - 11 cavity wall, 3 heating/boiler  |replacement; insulation; and voltage optimisers
replacements and 10 double glazing projects successfully completed. * Continuation of Schools Modernisation Investment Programme (aims to
+ 58 schools achieved awards in Eco Schools Programme: 13 Gold; 26 Silver; and |reduce 700 tonnes of carbon emissions over the next 5 years).
Energy 19 Bronze. * Implementation of Leisure Pool energy saving measures Ongoing
* Energy audit of NTC swimming pools conducted to identify energy saving * Maximise use of hub and spoke buildings and improve services through
opportunities agile working practices
» 1503 Solar PV arrays installed on NT Homes * Implement carbon budgets in a further 20 buildings
* Electricity useage (top 30 sites): down 9.5% against base yr
» Gas useage (top 30 sites): up 2% aginst base year (due to unusually long/cold
Winter)
» Water useage (top 30 sites): down 19% agianst base yr
* Vehicle fleet reduced by 25% * Further work on vehicle utilisation / fuel usage
* Vehicle tracking installed to facillitate improved route planning * Partnership arrangement for Vehicle Fleet Maintenance
* Home to School travel routes condensed
Transport * Vehicle utilisation improved; vehicle damage reduced Ongoing
* Fleet Diesel Fuel usage down by 9.8%
« Community Services Staff mileage down by 13%
» Soft market testing initiated for Vehicle Fleet Maintenance
« Staffing efficiencies totalling £550k delivered. * Review of Bereavement Services - options for refurbishment / service
Safer, Cleaner, Greener * Review of Bereavement and Pest Control charges delivery 31.03.15
» Ongoing monitoring of bereavement/pest control income
Carbon Reduction see energy
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